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Interactive Whiteboards makes every lesson a 
powerful and engaging visual experience for 

students and teachers alike.

Features, such as cloning and dragging objects, and whiteboard tools, such as highlighters, keep 
students actively engaged in learning. Teacher notes help maximise the instructional impact, more 

fully preparing students to complete the related Solve® practice independently.

® Example of STAMS  IWB lesson
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STAMS® Interactive Whiteboard (IWB) lessons enhance instruction by 
transforming lessons into engaging visual experiences. STAMS® IWB lessons 
are available for each lesson in the STAMS® Plus Series student books for 
level C–H. They offer students opportunities to question and explore 
mathematical concepts in greater depth.

Accessing STAMS® IWB lessons
STAMS® IWB lessons were created to run in a software program called 
ActivInspire™. The program presents a wide variety of tools that you can 
use to enhance and annotate the lessons. This user guide discusses some 
of the key tools available to you but does not offer detail about every 
ActivInspire™ tool. Refer to the ActivInspire™ Help system for details 
about the tools not mentioned in this guide.

STAMS® IWB lessons can also run in ActivStudio™, the forerunner of 
ActivInspire™. Both ActivStudio™ and ActivInspire™ were developed by 
Promethean Limited. The files are compatible with a variety of hardware, 
including SMART™ boards and Mimio® boards.

Integrating STAMS® IWB lessons with 
the print series

STAMS® IWB lessons can be used to teach new lessons or review previous 
lessons from STAMS® Plus levels C–H. For example:

• Use the IWB lesson in conjunction with part one and part two of each 
print lesson.

• Recap part one and part two before moving on to part three and part four 
of the print lesson.

• Review previous lesson’s content, from any level, before beginning 
instruction on a new lesson.

Welcome to STAMS® Interactive Whiteboard lessons
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Begin by moving through part one of each STAMS® IWB lesson in order – 
Explore, Think, Connect, Let’s Talk, Think It Through and Your Turn. 
When you complete Your Turn in part one, begin part two, moving through 
the pages in the same order. This is the order of part one and part two of 
the print lesson. Have students follow along in their books so they will know 
where to find explanations and examples they may need to review later.

You can refer back to part one and part two of each STAMS® IWB lesson 
when you work with other parts of the print lesson. And, of course, you can 
use the STAMS® IWB lesson as a review lesson for another lesson or year level.

Getting to know STAMS® IWB Lessons

Regardless of which lesson you have open, each STAMS® IWB lesson uses a 
consistent structure for identical lesson components in the print series.

Focus Questions

Each STAMS® IWB lesson presents a Focus Question on the Notes page for 
Explore. Use the question to frame the lesson and set a purpose for learning. 
The question not only identifies the core concept of the lesson, but gets 
students thinking about the answer arrived at through Explore, Think and 
Connect.

Explore

Use Explore to engage your students, activating their prior knowledge of the 
concept introduced. Encourage them to share their knowledge and check to 
see that they have the proper tools to succeed. For example, be sure to review 
prerequisite concepts and vocabulary essential to understanding the lesson.

Time and pacing

Spend 2 to 3 minutes discussing the Explore information. The time will 
vary depending on the depth of students’ prior knowledge, the number 
of vocabulary terms and students’ familiarity with the terms.

Using STAMS® IWB lesson content
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Using STAMS® IWB lesson content

Think

Think presents step-by-step interactive content to guide students’ thinking 
about new concepts and skills. Pull-down screens offer an additional method 
for ensuring students stay focused, and write-on lines allow students to input 
answers and compare them to the answers supplied in their books. Be sure to 
discuss with students how they arrived at each answer.

Remind students that material from the STAMS® IWB lesson appears in 
their books too. When you make notes or highlight elements on the page, 
encourage students to do the same in their books. Student notes become an 
additional reference for independent learning.

Time and pacing

Work deliberately through the steps in Think, pausing to be sure 
students understand why the questions or statements are completed 
as they are. Depending on the number of steps and amount of new 
vocabulary, this will take 5 to 7 minutes. This is the section where 
understanding is developed, so take time to manipulate and discuss 
the visuals so that all students are comfortable with the material before 
moving on.

Connect

Connect presents the core content of the lesson, answering the Focus 
Question. Use the interactive features of Connect to reinforce key concepts 
and skills.

Time and pacing

Be sure to discuss this section in depth with students. Ask questions to 
check students’ understanding. Interact with the onscreen features to 
provide a variety of examples. Expect to spend about 5 to 6 minutes in 
Connect.

Let’s Talk

Use Let’s Talk to get students thinking more deeply about what they have just 
learned and communicating their understanding to their peers. You can add a 
blank page to record the discussion or copy the original page so small groups 
of students can interact with it separately and present their ideas to the class. Be 
sure to save student work by selecting Save As from the STAMS® IWB lesson 
File menu.

Time and pacing

You’ll discuss some Let’s Talk questions longer than others. Allow more 
time for open-ended discussions. Allow students to discuss questions in 
pairs and to use the IWB to explain their thinking. As necessary, record 
student responses. Let’s Talk pages will take about 4 to 6 minutes.
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Think It Through and Your Turn

Think It Through and Your Turn in each STAMS® IWB Lesson present 
problems and supporting information identical to the correlated sections of 
the Student Book page. Use the space on the right to write notes to show 
how to reason through the problems.

The Teacher guide provides answers for the Think It Through and Your 
Turn problems.

Think It Through

Think It Through keeps students engaged in problem solving. Encourage 
students to write in their books as the class works through and records 
each step of the solution on the IWB. Use the STAMS® IWB lesson tools to 
interact with the Think It Through pages. See the teacher guide for answers.

Time and pacing

Walk through the solution step-by-step as a class, using the IWB to 
illustrate examples, record calculations, draw diagrams and so on. This 
should take approximately 5 to 6 minutes.

Your Turn

Your Turn offers an opportunity for students to work alone or in pairs, while 
referring to their books. Students can share their solutions on the STAMS® 
IWB lesson page and discuss their work. Be sure to use errors as opportunities 
for learning. See the teacher guide for answers.

Again, you can add a blank page or copy the original page so small groups 
of students can interact separately. Be sure to save student work by selecting 
Save As from the STAMS® IWB lesson File menu.

Time and pacing

Allow time for students to solve the problem. The time will vary 
depending on the number of steps and computations involved. 
Generally, you can plan on 2 to 3 minutes. Then spend 3 to 4 minutes 
discussing the correct answer. Use white space on the page and, if 
necessary, return to previous pages to help struggling students apply the 
instruction to the Your Turn problem. Consider copying an existing 
page and marking the diagrams or tables with the information in the 
Your Turn problem.

Using STAMS® IWB lesson content
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Making the most of STAMS® IWB lessons

Be prepared!

• Be sure to review lessons before you present them to the class. You’ll feel 
more comfortable with content that you’re familiar with and you’ll be 
ready to use the interactive features.

• Preview the Teacher Notes so you know the page features for the lessons.

• Deactivate the screen saver on the computer you are using to present the 
STAMS® IWB lesson.

Personalise the lessons

• Adjust the lessons so they have more personal meaning for your students.
For example, you can change the pets in a chart so they reflect pets the 
students know.

• Extend the lesson to answer questions and give more practice. Change or 
add more equations to a slide. Or, use the shapes in the Main Toolbox to 
extend a geometry lesson.

• Duplicate a slide so you can adjust content but retain the original slide.

• Use the Pen, Highlighter or other tools to emphasise page elements.
You can even use the Zoom In feature to take a closer look at something.

Class participation

• Invite your students to complete activities at the IWB.

• Have students work at their seats, then come to the IWB to show how they 
solved a problem.

• Have students work in groups, then invite a representative to come to the 
IWB to show their work.

• Have students create a presentation on the IWB to teach something to 
their classmates.

• If you use response devices, gather class feedback. If you don’t have 
response devices, you can use slates or a show of hands.

Save your presentations

• You can save your presentation as a flipchart or PDF and post it to your 
class website where students can access it for further study.

• If a screen recorder is available, use it to capture the onscreen activities.
Consider using a microphone, too.

• Open a lesson before you teach it and make any adjustments needed for 
your class. For example, you might want to add extra skills practice.

Teacher tips!
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Please note that no matter what interactive whiteboard you have, you will need to download and 
install Promethean Activlnspire software in order to use and view STAMS® Interactive Whiteboard 
lessons. Promethean software and STAMS® Interactive Whiteboard lessons work on all interactive 
whiteboards.

Installation instructions

You will need up to 30 minutes to download and install Promethean ActivInspire software (depending 
on the speed of your lnternet connection).

 :knil siht ot etagivaN  )1
https://support.prometheanworld.com You will be taken to the Promethean website. 

2) Select the correct download link for your operating system

Or Or

Directions for using and viewing STAMS® IWB lessons
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)cte sserdda ,eman .g.e( daolnwod nac uoy erofeb retsiger ot setunim owt ekat ot deen lliw uoY  )3

 dengis eb lliw uoy emit siht( 2 dna 1 spets taeper ,neercs evoba eht morf yawa detagivan era uoy fI  )4
in and will be able to download). Click on the download button that will now appear below the 
version that you need (Windows, Mac or Linux).

.nigeb lliw daolnwod eht dna eriannoitseuq pu-pop feirb eht ni sdlefi deriuqer eht tuo lliF  )5

6) A pop-up window will appear. Click “Run”.
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 51–4 neewteb ekat lliw sihT .daolnwod eht fo sutats eht uoy wohs lliw wodniw pu-pop ehT  )7
minutes.

8) Another pop-up will ask if you want to run the software (it might say ‘file’). Click “Run”.

9) Continue to let run (it might say ‘unpacking’ or ‘extracting’), do not close if prompted.
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10) The Installation Wizard (called “Install Shield Wizard”) will launch automatically.

11) Click “Next”.

12) “Full Install” will be preselected. Click “Next”.

13) Click “Next”.
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14) Select “I accept the terms of the license agreement”. 

15) Click “Next”.

 erehw redlof tceleS .noitacoL noitanitseD esoohC“ yas won dluohs neercs ruoy ,rab wolley eht nI  )61
setup will install files.”
On the main part of the screen, your screen should say “Setup will install ActivInspire v1 in the 
following folder.”

17) Click “Next”.
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”.redlof gniwollof eht ni secruoseR llatsni lliw puteS“ yas won lliw neercs ruoy fo trap niam ehT  )81

19) Click “Next”.

20) Click “Start”.

Note: the program is being installed
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21)  Click “Finish”.

.potksed ruoy no erawtfos eripsnIvitcA naehtemorP eht ot tuctrohs a dnfi lliw uoY     )22

Start the lesson

When you are ready to start your Interactive Whiteboard lessons, double click on the STAMS® IWB 
lesson that you saved to your desktop (e.g. STAMS_C_Lesson_16). You should see the following 
screen.

Next, a “Promethean License Agreement” pop-up will appear.
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You don’t need to enter anything in the fields at the top.

Click in the “I accept the terms of this license” box. Once you do, the “Run Personal Edition” button 
will become active.

Click “Run Personal Edition”.

A “Welcome to ActivInspire” pop-up will appear. Select “Other Applications (such as Powerpoint)” 
and click “Continue”.
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The Activlnspire software will now launch and show you the Activlnspire ‘dashboard’ (the small
pop-up window) and the STAMS® Interactive Whiteboard lesson (the red screen in the background).
Once you close out the dashboard by hitting the ‘Close’ button, you are ready to start using the
STAMS® Interactive Whiteboard lesson!

NOTE: Each time you launch Activlnspire, you will get the Promethean License Agreement.
Remember that if you want to use the Personal Edition (free) you don’t have to fill in the
fields, just click on “I accept” then click on “Run Personal Edition”. You never have to
click on Buy Now or do the 60-day trial as the Personal Edition is free to all users.
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Getting to know the STAMS® 
IWB lesson interface

STAMS® IWB lessons offer intuitive tools for 
working on the lesson pages. Lessons use a 
standard layout and a consistent structure, so 
you can focus on the lesson content and your 
students.

Lessons are colour-coded to coordinate with 
the colour-coded levels in the STAMS® print 
series.

The home page

The home page offers a consistent layout.

An IWB lesson includes each section 
of part one and part two in the student 
book. Click a button to open the STAMS® 
IWB lesson section.

There is one file for each STAMS® Plus lesson 
in levels C–H. STAMS® IWB lessons show 
the lesson number and name as well as the 
STAMS® Plus book and coordinating colour.

A

B

STAMS® IWB lesson interface

B

B

A
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Navigating lesson pages

Because lessons always flow across several 
interactive pages, STAMS® IWB lessons present 
tools for navigating the pages.

Click the Back or Next button to move 
back or forward in the lesson, one page at 
a time.

The current STAMS® IWB lesson section 
name is highlighted when it is active. You 
can click another section name to open a 
different section.

Some sections have multiple pages. Click 
a page number to move directly to that 
page in the lesson.

Click the Home icon to return to the 
home page where the lesson content is 
displayed.

 segnahc odnu ot noci teseR eht kcilC 
you’ve made to the page. The current 
page reverts to the original settings. The 
Reset feature changes only the current page. 
See “Lesson tools and features” for more 
information.

Click the Notes icon to see information 
about how to use the current page. See 
“Teaching with the Lessons” for more 
information.

A

B

C

D

E

F

A

C
B D E F
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STAMS® IWB lessons make use of valuable 
interactive elements to engage students in 
learning and to enhance the instructional 
experience. The tools available on each page 
vary, depending on the page content.

This user guide does not describe all on-page 
elements. Rather, it describes prominent 
features that will likely lead you to discover 
additional interactive features. Remember, 
STAMS® IWB lessons are filled with interactive 
opportunities. We encourage you to explore 
the pages to discover the best way to use them 
in your classroom. Click the Notes icon on 
lesson pages for tips on some of the interactive 
features that are available.

Notes

Notes offer you valuable insight into how to 
use the current page. Because they are derived 
directly from STAMS® Plus teacher guide 
content, you won’t need to go back and forth 
between the book and a STAMS® IWB lesson. 
The Notes differ depending on the page from 
which you open them. They may identify the 
functionality available on the page, provide 
answers (in red) to questions on the student 
page, offer extension questions and answers or 
provide reinforcement tips or EAL/D support.

You can add your own information to any of 
the Notes pages. Simply click the Notes icon 
and select the Text tool     in the Main Toolbox. 
Then type your own notes in the section. Be 
sure to preserve your changes by selecting 
Save As from the File menu.

Teaching with the lessons

A

A

A
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Print

Print a copy of the Notes in advance so you 
have them on hand when you go through the 
STAMS® IWB lesson pages in the classroom. 
Select Print from the File menu. Then check 
the Include page notes box and the Print 
notes only box and click Print.

Pin

You can pin the Notes so they stay open, even 
when you move to another page. Click the 
pin  in the upper right corner of the Notes 
section. When the pushpin appears with a 
highlight, the Notes section remains open. 
Click the pin again to hide the Notes section. 
Click the x button to close the Notes section.

Pop-up vocabulary words

Many lessons include vocabulary terms – the 
same terms that are included in the student 
book. These vocabulary terms appear with 
yellow shading or highlighting, around 
them. Click a highlighted word to open the 
definition. Click the Close button in the 
definition box to close the definition.

Pull-tabs

Pull-tabs allow you to move information on 
and off the page. When you drag the pull-tab 
arrow on to the page, additional information 
appears. For example, the pull-tab might 
provide the data needed to solve a problem, a 
formula or the solution to a problem.

Drag the information anywhere on the page or 
close the pull-tab by dragging it off the page.
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Using the Pen

STAMS® IWB lessons include areas where you 
or students can enter solutions. Click the Pen 
tool in the Main Toolbox to fill in answers.

If you want to change the solutions, click Reset 
or click the Eraser tool in the Main Toolbox. 
See “Lesson tools and features” for more 
information.

Clonable art

STAMS® IWB lessons allow you to clone many 
of the art elements. Clonable art is easy to 
identify. Simply move your cursor over an 
element. If the cursor changes to a hand with a 
plus sign in a green circle , you can clone the 
art. Each time you click a clonable element, you 
create a copy of the element. Drag the cloned 
element anywhere on the page.

Shifting objects on a page

You can move many of the objects on STAMS® 
IWB lesson pages. Simply select the object, in 
this case a basketball  and drag it to a new 
location on the page. Use drag and drop to 
deepen student understanding of pictographs 
and to examine the relationships among 
objects.

In most cases, STAMS® IWB lessons are 
designed so you can shift and manipulate the 
elements to meet your needs. For example, you 
can shift the height of bars in a graph, move 
counters from one side of the page to the other 
or move elements on a single page.

Remember, the Notes section always gives you 
tips for working in the current lesson.
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Click-through boxes

Click-through boxes allow you to move 
through a set of numbers one at a time. They 
provide a simple way to practise a skill using 
a variety of numbers. When you see a shaded 
box, click it to change the number in the box. 
Continue to click the box to cycle through the 
available numbers.

Blank lines

A blank line indicates that you can use the 
Pen tool to fill in an answer. The Pen tool is 
available from the Main Toolbox. See “Lesson 
tools and features” for more information.
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 Manipulating shape models

STAMS® IWB lessons offer several types of 
models that you can manipulate to enhance the 
lesson.

For example, you can reshape or rotate a 
geometric figure, shift the rays in an angle 
diagram and even drag shapes onto the page. 
Remember to refer to the Notes for details 
about the options available for manipulating 
models on the current page. 

Before you begin a lesson, review the onscreen 
shape models to familiarise yourself with the 
actions you can perform.

A

A
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Sliding screens

STAMS® IWB lessons offer sliding screens to 
temporarily cover some of the page content. 
Pull the bar of the sliding screen down to 
reveal content gradually. Sliding screens allow 
you to customise the pace of your lesson to 
accommodate student needs and provide a 
simple tool for engaging students one line at a 
time. Drag the arrows up to hide the content.

Manipulating graphics

STAMS® IWB lessons make use of several types 
of models that you can manipulate to enhance 
the lesson. Refer to the Notes for details about 
the options available for manipulating models 
on the current page.

A B
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Lesson tools and features 
The Main Toolbox and the menus in ActivInspire™ present several tools 
you can use to enhance or edit the STAMS® IWB lesson pages. This section 
describes several of the more commonly used tools. Explore the toolbox and 
menus to discover additional features. Open the ActivInspire™ Help system 
from the Help menu to learn more about any of the features.

Zooming in and out

You can enlarge or shrink a STAMS® IWB lesson page or you can zoom in or  
zoom out of a specific region.

To magnify a region, press Ctrl + Shift + Z. When the magnifying glass 
icon appears , click the page; then press and hold the cursor. To zoom out, 
right-click the page and press and hold the cursor.

You can also select a magnification setting from the list at the upper right of 
the page. Open the list and select a page magnification level or a general level 
such as Fit to width.

Using the pen and highlighter 

If you prefer a pen colour other than black, select a colour from the colour 
palette. Then click the Pen tool and drag the cursor to write or draw on the 
STAMS® IWB lesson page.

The Highlighter tool works in much the same way. Select a highlight colour 
from the colour palette and click the Highlighter tool. Then drag the 
cursor to create a highlighted line or shape.

Use the Pen width tools to change the size of the pen or highlighter stroke.

Eraser 

You can erase any element that you’ve added to the STAMS® IWB lesson 
page. Click the Eraser tool in the Main Toolbox and move it over the area 
on the page you would like to remove. Use the Pen width tools to change 
the size of the eraser.

You cannot erase elements that are included in the original STAMS® IWB 
lesson pages.
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Copy a page

It’s very likely that you’ll want to 
duplicate an existing page and use it as 
the foundation for a new page. The Copy 
feature allows you to select a page to 
copy and to create as many duplicates as 
necessary. You can copy pages from the 
Page Browser.

Select Browsers from the View menu 
and open the Page Browser. Scroll 
through the thumbnail pages and select 
the page you would like to copy. Then 
right-click the page and select Copy from 
the pop-up menu.

In the Page Browser, right-click the 
thumbnail page directly before where you 
want to insert the copied page. Select 
Paste from the pop-up menu.

You can copy and paste more than one 
page at a time. Open the Help system 
from the Help menu to learn more about 
the Copy and Paste features.

Save page changes

Because the customisations and annotations you and your students add to 
STAMS® IWB lessons are very valuable, you can preserve them with the Save 
As command. Save As, available from the File menu, allows you to save your 
changes to a new lesson while retaining a copy of the original lesson. When 
you use Save As, supply a name for the new lesson and specify a location to 
store it.

Print the pag es or export to PDF

You can print any open STAMS® IWB lesson or export it to PDF format. 
Select Print from the File menu and specify settings in the print box that 
opens. Be sure to select Include page notes if you’d like to include the 
Notes section in the print or PDF file.

Reset the page

Even though STAMS® IWB lesson pages are meant to be annotated and 
customised, you might want to reset the pages so they revert to the original 
settings. When you click the Reset button, your changes are cleared and the 
page returns to its original state as long as you haven’t saved changes.

If you want to preserve changes you’ve made to a lesson, be sure to use the 
Save As command before you click the Reset button.

A Reset button is available on each lesson page as well as on the toolbar.


